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Microsoft PowerPoint-2016. 
 

Chapter-1. What Is PowerPoint? Ms. PowerPoint is the presentation package. This 

application software is developed by Microsoft Corporation. It is used to make slideshow, 

design, & formatting, set animation, sound in particular slide. This is mostly use in display 

project overview, display program on monitor or projector. PowerPoint is a presentation 

program that allows you to create dynamic slide presentations. These presentations can 

include animation, narration, images, videos, and much more. In this lesson, you'll learn 

your way around the PowerPoint environment, including the Ribbon, Quick Access Toolbar, 

and Backstage view. 
 

Extension Name of Ms. PowerPoint File.  .PPT (PowerPoint Presentation.). 
 

How to Open Ms. PowerPoint? 
 

Click on Start Button > Programs > Microsoft Office Folder > PowerPoint 2016. 
 

Click on Window Button > Search > Type > PowerPoint 2016. > Enter. 
 

Double Click on MS. PowerPoint. Icon on Desktop. 
 

Press Window+R > Run > Type > Powerpnt > Ok or Enter. 
 

 
 

Title Bar. A horizontal bar at the top of a window, bearing the name of the program and 

typically the name of the currently active document include three button Minimize, Maximize, 

And Close button. 
 

Microsoft Office Button. This command related to managing word document menu that is 

display when you click the Microsoft office button. 
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Quick Access Toolbar. This command can be display button on the quick access toolbar. By 

default display the save, new open, print, buttons. You can customize toolbar include 

according to you. 
 

Ribbon. This command can be display below the title bar you can make all the capability of 

word available in single area and you can work. PowerPoint uses a tabbed ribbon 

system instead of traditional menus. The ribbon contains multiple tabs, each with 

several groups of commands. For example, the font group on the home tab contains commands 

for formatting text in your document. 
 

Auto-Hide Ribbon. Auto-hide displays your workbook in full-screen mode and completely 

hides the ribbon. To show the ribbon, click the expand ribbon command at the top of screen. 
 

Show Tabs. This option hides all command groups when they're not in use, but tabs will 

remain visible. To show the ribbon, simply click a tab. 
 
 

Show Tabs and Commands. This option maximizes the ribbon. All of the tabs and commands 

will be visible. This option is selected by default when you open PowerPoint for the first time. 
 

Status Bar. This command can be display bottom of window program status bar give all 

information of current document.  
 
 

 

Control Buttons Title Bar Menu Bar 

Status Bar 

Work Area Ruler 
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Chapter-2. File. (Alt+F). 
 

Information. The info pane will appear whenever you access backstage view. Its. Contains 

information about the current information. 
 

PowerPoint Feature. When developing a presentation with more than a dozen slides, you can 

work on subsets of slides by creating sections. Sections are not visible to the audience, but 

they help you organize your slides logically and format them efficiently. 
 

New (Ctrl+N). This option is used to create a new blank presentation. When you open 

PowerPoint for the first time, the Start Screen will appear. From here, you'll be able to create a 

new presentation, choose a template, and access your recently edited presentations. From the 

Start Screen, locate and select Blank Presentation to access the PowerPoint interface. 
 

 
 

Open (Ctrl+O). In addition to creating new presentations, you'll often need to open a 

presentation that was previously saved. To learn more about saving presentations, visit our lesson 

on saving presentations. Select the file tab to go to backstage view, then click open. Click browse. 

Alternatively, you can choose one drive to open files stored on your one drive. The open dialog 

box will appear. Locate and select your presentation, then click open. 

 

http://www.gcflearnfree.org/powerpoint2016/saving-presentations/1/
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Save (Ctrl+S). When you create or edit a presentation, you'll use the save command to save your 

changes. You'll use this command most of the time. When you save a file, you'll only need to 

choose a file name and location the first time. After that, you can just click the save command to 

save it with the same name and location. 
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Save As (F12). You'll use this command to create a copy of a presentation while keeping the 

original. When you use save as, you'll need to choose a different name and or location for the 

copied version. The save as dialog box will appear. Select the location where you want to save 

the presentation. Enter a file name for the presentation, then click save. 
 

Print (Ctrl+P). Even though PowerPoint presentations are designed to be viewed on a computer, 

there may be times when you want to print them. You can even print custom versions of a 

presentation, which can be especially helpful when presenting your slide show. The print pane 

makes it easy to preview and print your presentation. 
 

 

 

Print Layout. PowerPoint offers several layouts to choose from when printing a presentation. 

The layout you choose will mostly depend on why you're printing the slide show. There are four 

types of print layouts. 
 

Full Page Slides. This prints a full page for each slide in your presentation. This layout is most 

useful if you need to review or edit a printed copy of your presentation. 
 

Notes Pages. This prints each slide, along with any speaker notes for the slide. If you've included 

a lot of notes for each slide, you could keep a printed copy of the notes with you while presenting. 
 

Outline. This prints an overall outline of the slide show. You could use this to review the 

organization of your slide show and prepare to deliver your presentation. 
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Hand-Outs. This prints thumbnail versions of each slide, with optional space for notes. This 

layout is especially useful if you want to give your audience a physical copy of the presentation. 

The optional space allows them to take notes on each slide. 
 

Print Button. When you are ready to print the presentation click the print button.  
 

Copies. You can choose how many copy of presentation you want to print. 
 

Printer. You can select the printer you want to use if your computer is connected to multiple 

printer. 
 

Colour. You can choose whether to print in colour or grayscale. We recommended printing in 

grayscale most of time to save colour ink. 
 

Preview Pane. You can see a preview of how your presentation will look when printed. 
 

Share. PowerPoint makes it easy to share and collaborate on presentations using One Drive. 

In the past, if you wanted to share a file with someone you could send it as an email attachment. 

While convenient, this system also creates multiple versions of the same file, which can be 

difficult to organize. Click the file tab to access backstage view, then click share. The share 

pane will appear. 
 

 

 

Invite People. You will be able invite other to view or edit presentation. 
 

Send In Email. This option is used to attach file and send from internet. You can share your 

presentation directly through Microsoft Outlook.   
 

Present Online. You can share your presentation online as a live presentation. PowerPoint 

will generate a link that other can open in their web browser.   
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Publish Slide. You can used PowerPoint to post entries directly to your blog. Such as share 

point blog, word press and blogger. 
 

Export. By default, PowerPoint presentations are saved in the .pptx file type. However, there 

may be times when you need to use another file type, such as a pdf or PowerPoint 97-2003 

presentation. It's easy to export your presentation from PowerPoint in a variety of file types. 

Click export, then choose the desired option. In our example, we'll select change file type. 
 

 

 

PDF. Saves the presentation as a PDF document instead of a PowerPoint file. 
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Video. Saves the presentation as a video. 
 

Package for CD. Saves the presentation in a folder along with the Microsoft PowerPoint 

Viewer, a special slide show player anyone can download 
 

Hand-outs. Prints a hand-out version of your slides. 
 

Other File Type. Saves in other file types, including PNG and PowerPoint 97-2003 
 

Exit (Alt+F4). This command is allowing exit from MS. PowerPoint window application. 
 

Chapter-3. Home (Alt+H). 
 

 
 

Clipboard. 
 

Undo (Ctrl+Z). This command is used to reverse the last action. To take backward in your 

current work which you have done. Or you can choose this command repeatedly to step 

progressively backwards through your changes, even after you save the document. 
 

Redo (Ctrl+Y). Restores whatever changes you just made by using the undo command. 

Selecting redo multiple times moves you progressively forward through changes you undid. 

If you just used a command other than undo, repeat appears instead of redo. This property lets 

you repeat the last action. For example, if you just pressed delete, the repeat command presses 

it again. 
 

Cut (Ctrl+X). You can deletes the selected text or objects from a document, and copies them 

to the invisible windows or Macintosh clipboard so you can paste them elsewhere. (The 

clipboard holds only one selection at a time.). Remove the selection and put it on clipboard 

so you can paste it somewhere else. 
 

Copy (Ctrl+C). This command is used to copies the selected item to your computer's memory 

and available in clipboard use for later. Put a copy of the selection on the clipboard so you 

can paste it somewhere else. 
 

Paste (Ctrl+V). This command is used to places objects you’ve copied to your computer's 

memory into the current document. Places the most recent selection from the clipboard into 

your document at the insertion point. Add content on the clipboard to your document. 
 

Format Painter. (Ctrl+Shift+C). Used the Format Painter on the Home tab to quickly apply 

the same formatting, such as colour, font style and size, and border style, to multiple pieces of 

text or graphics. The format painter lets you copy all of the formatting from one object and 

apply it to another one – think of it as copying and pasting for formatting. 
      

Slides. 
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New Slide (Ctrl+M). When you insert a new slide, it will usually have placeholders to show 

you where content will be placed. Slides have different layouts for placeholders, depending on 

the type of information you want to include. Whenever you create a new slide, you'll need to 

choose a slide layout that fits your content. Placeholders can contain different types of content, 

including text, images, and videos. Many placeholders have thumbnail icons you can click to 

add specific types of content. In the example below, the slide has placeholders for 

the title and content. 
 

 
 

Duplicate Slides. PowerPoint presentations can contain as many slides as you need. The Slide 

Navigation pane on the left side of the screen makes it easy to organize your slides. From there, 

you can duplicate, rearrange, slides in your presentation. Duplicate slides if you want to copy 

and paste a slide quickly, you can duplicate it. To duplicate slides, select the slide you want 

to duplicate, right-click the mouse, and choose duplicate slide from the menu that appears. 

You can also duplicate multiple slides at once by selecting them first. 
 

Slides from Outline. Base your presentation an outline in word, insert outline text from word 

to your PowerPoint presentation ... Click slides from outline. 
 

Reuse Slides. To import slides from another presentation, click the home tab. In the slides 

group, click the arrow below new slide, and then select reuse slides. Add, rearrange, and 

delete slides in PowerPoint applies ... Reuse (import) slides from another presentation. Basic 

tasks for creating a PowerPoint presentation. 
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Slide Layout. Each slide layout contains placeholders for text, videos, pictures, charts, shapes, 

clip art, a background, and more, and they also contain the formatting, such as. When you 

insert a new slide, it will usually have placeholders to show you where content will be placed. 

Slides have different layouts for placeholders, depending on the type of information you want 

to include. Whenever you create a new slide, you'll need to choose a slide layout that fits your 

content. The new slide will appear. Click any placeholder and begin typing to add text. You 

can also click an icon to add other types of content, such as a picture or a chart. 
 

 
 

Reset. Reset the position, size, and formatting of the slide placeholders to their default settings. 
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Section. If you have a lot of slides, you can organize them into sections to make your 

presentation easier to navigate. Sections can be collapsed or expanded in the slide navigation 

pane and named for easy reference. Select the slide you want to begin a section. From 

the home tab, click the section command, then choose add section from the drop-down menu. 
 

 

 

Rename Section. To rename the section, click the section command, then choose rename 

section from the drop-down menu. 
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Remove Section. To remove a section, click the section command, then click remove section. 

You can also click remove all sections to remove all sections from your slides. 
 

Font. 
 

Font (Ctrl+Shift+F). You can choose from a list of common font combinations to apply a 

font set to the selected text. When a visitor’s browser displays that text, it moves down the list 

of assigned fonts until it finds one installed on his computer. You can create your own 

combination of paragraph fonts by going to the submenu and choosing edit font list. Pick a 

new font for your text. 
 

 
 

Font Size (Ctrl+Shift+P). Font size is measurement in point the larger font size approximately 

96 point in an inch. You want to change font formatting at the same time. You can change font 

size font dialog box. 
  

Increase Font Size (Ctrl+Shift+>). You can increase the font size by using the grow font. Or 

make your text a bit bigger. Grow and shrink font commands. Click the grow font or shrink 

font commands to change the font size. 
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Decrease Font Size (Ctrl+Shift+<). You can reduce the font size by using the shrink font. Or 

make your text a bit smaller.  
 

Clear All Formatting. You can easily clear all formatting (such as bold, underline, italics, 

colour, superscript, subscript, and more) from your text and return your text to its default 

formatting styles. Remove all formatting from selection leaving only normal unformatted text.  
 

Bold Font (Ctrl+B). You can make your text matter bold. The selected text will be modified 

in the document. 
 

Italic Font (Ctrl+I). You can italicize your text matter. The selected text will be modified in 

the document. 
 

Underline Font (Ctrl+U). You can underline your text matter. The selected text will be 

modified in the document. 
 

Text Shadow. Add a shadow behind the selected text to help it stand out on the slide. 
 

 
 

Strikethrough. Cross something out by drawing a line through it. 
 

Character Spacing. Adjust the spacing between characters. 
 

Change Case. Change the selected text to uppercase, lowercase, or other common 

capitalizations. You want to change its case to display the change case dialog box choose the 

option you want and click ok. A drop-down menu will appear. Select the desired case option 

from the menu. 
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Font Color. This option is used to select text matter and change text matter colour. Your 

colour choices aren't limited to the drop-down menu that appears. Select more colours... At the 

bottom of the menu to access the colours dialog box. Choose the colour you want, then 

click ok. Select the font colour you want to use. The font colour will change in the document. 
 

 
 

Bullets List. Create a bulleted list. Click arrow to change the look of the bullet. PowerPoint 

provide the capability to add flair to your documents through the use of bulleted list. Document 

are far from text only and you can easily add formatted graphics elements to get your points. 

From here you can choose bullet as picture symbol etc. On the home tab, click the drop-down 

arrow next to the bullets command. A menu of bullet styles will appear. 
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Numbering. Create a numbered list. Click the arrow for more numbering formats. If you have 

more than one numbered list in Powerpoint document. Powerpoint starts each new list at 

number1. If you want the numbering to continue from the previous list. Click on the first 

paragraph of the new list chose format numbering click the numbering tab mark continue 

previous button and click ok. When you need to organize text into a numbered list, Powerpoint 

offers several numbering options. You can format your list with numbers, letters, or roman 

numerals. 
 

 
 

Decrease Indent.  Move your paragraph closer to the margin. Indent determines the distance 

of the paragraph from either the left or the right margin. Within the margins you can decrease 

of a paragraph or group of paragraph. 
 

Increase Indent. Move your paragraph farther way from the margin. Indent determines the 

distance of the paragraph from either the left or the right margin. Within the margins you can 

increase of a paragraph or group of paragraph. 
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Line Spacing. Choose how much space appears between lines of text between paragraphs. To 

apply the same spacing to whole document use paragraph spacing option on the design table. 

Line spacing is the amount of space between lines in a paragraph. By default paragraph are 

single spacing. You might want to double space a school paper or a draft report. 1.5 line 

spacing better than single spacing because it can make the text a little easier to read.  
 

 
 

Text Direction. Change orientation of text to vertical stacked or rotate it to the desired 

direction. 
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Align Text Left (Ctrl+L). Align your content to the left margin. Left alignment is the 

commonly used for body text and make document easier to read.  
 

Centre (Ctrl+E). Centre your content on the page. Centre alignment gives documents a formal 

appearance and is often use for covers page, quotes, and sometime headings. 
 

Align Text Right (Ctrl+R). Align your content to the right margin right alignment is used for 

small sections of content, such as text in your header or footer. Right alignment lines up your 

text at the right margin and gives it a ragged left edge. This type of alignment works well for 

short lines of text that you want to appear on the right edge of the page. 
 

Justify (Ctrl+J). Distribute your text evenly between the margins. Justified text gives your 

document clean, crisp, edges so it looks more polished. Justified text can be a little hard on the 

eyes because the spacing is uneven but it is appropriate in some situations.  
 

 

 

Add or Remove Columns. Split your text into two or more columns. You can also choose the 

width and spacing of your columns or use one of the preset formats. Your column choices 

aren't limited to the drop-down menu that appears. Select more columns... At the bottom of 

the menu to access the columns dialog box. Click the arrows next to the number of columns 

to adjust the number of columns. 
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Covert to SmartArt. A SmartArt graphic is a visual representation of your information and 

ideas. You can create SmartArt graphics by choosing from among many different layouts to 

quickly, easily, and effectively communicate your message. SmartArt graphics, especially 

combined with other features such as themes, help you create designer-quality illustrations 

with only a few clicks of your mouse.  

 

Shape. You can add shapes, such as boxes, circles, and arrows, to your documents, email 

messages, slide shows, and spreadsheets. To add a shape, click insert, click shapes, select a 

shape, and then click and drag to draw the shape. After you add one or more shapes, you can 

add text, bullets, and numbering to them, and you can change their fill, outline, and other 

effects on the format tab. Shapes are a great way to make your presentations more interesting. 
  

 
 

Arrange. In addition to aligning objects, PowerPoint gives you the ability to arrange objects in 

a specific order. The ordering is important when two or more objects overlap because it will 

determine which objects are in the front or the back. When objects are inserted into a slide, 

they are placed on levels according to the order in which they were inserted into the slide. In 

our example, we've drawn an arrow on the top level, but we can change the level to put it 

behind the other objects. 
 

Bring To Front. Bring the selected objects in front of all other objects.  
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Send To Back. Send the selected objects behind all other objects. From the Format tab, click 

the Bring Forward or Send Backward command to change the object's ordering by one level. 

If there are multiple objects on the slide, you may need to click the command several times to 

achieve the desired ordering. 
 

 
 

Bring Forward. Bring the selected object forward one level so that it’s hidden behind few 

objects. 
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Send Backward. Send the selected object back one level so that it’s hidden behind more 

objects. 
 

 
 

Group. You may want to group multiple objects into one object so they will stay together if 

they are moved or resized. This is often easier than selecting all of the objects each time you 

want to move them. Pictures, shapes, clip art, and text boxes can all be grouped; 

however, placeholders cannot be grouped. If you will be grouping pictures, use one of the 

commands in the images group on the insert tab to insert pictures instead of the picture icon 

inside the placeholder. 
 

 
 

Ungroup. Break the connection between grouped objects so that you can move them 

individually against. 
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Align Objects. When you move objects in PowerPoint, alignment guides and spacing 

guides will appear as dashed orange lines and arrows around the objects to help you align 

them. However, if you have many different objects on a slide, it may be difficult and time 

consuming to get them perfectly aligned. Luckily, PowerPoint provides you with several 

alignment commands that allow you to easily arrange and position objects. 
 

 
 

Rotate. PowerPoint slides are automatically set up in landscape (or horizontal) slide view, but 

you can change the slide orientation to portrait (or vertical) slide view. 
 

 
 

Selection Pane. See a list of all your objects. This makes it easier to select objects change their 

order or change their visibility. If you have several objects placed on top of each other, it may  
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Be difficult to select an individual object. The selection pane allows you to easily drag an 

object to a new location. To access the selection pane, click selection pane on the format tab. 
 

 
 

Quick Styles. This option is used to quickly add a visual style to the selected shape or line. 

Choosing a shape style allows you to apply pre-set colours and effects to quickly change the 

appearance of your shape or text box. These options will depend on the colours that are part 

of your current theme. A drop-down menu of styles will appear. Select the style you want to 

use. 
 

 
 

Shape Fill. PowerPoint allows you to modify shapes and text boxes in a variety of ways so 

you can tailor them to your projects. You can change shapes and text boxes into different 

shapes, format their style and colour, and add effects. If you want to use a different type of fill, 
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select Gradient or Texture from the drop-down menu. You can also select No Fill to make it 

transparent. 
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Shape Outline. On the format tab, click the shape outline drop-down arrow. The shape 

outline menu will appear. From the drop-down menu, you can change the 

outline colour, weight (thickness), and whether it is a dashed line. 
 

 
 

Shape Effete. On the format tab, click the shape effects drop-down arrow. In the menu that 

appears, hover the mouse over the style of effect you want to add, then select the desired 

pre-set effect. Apply a visual effect to the selected shape such as shadow, glow, reflection or 

3-D rotation.  
  

 

 



Vinod Computer Institute Mehnagar Azamgarh UP. 

--------------------------------------------------------------------------------------- 

28 | P a g e  
 

Editing. 

Find. (Ctrl+F). When you're working with longer presentations, it can be difficult and time 

consuming to locate a specific word or phrase. Powerpoint can automatically search your 

presentation using the find feature, and it allows you to quickly change words or phrases using 

the replace feature. From the home tab, click the find command. 
 

 
 

Replace. (Ctrl+H). At times, you may discover that you've repeatedly made a mistake 

throughout your presentation—such as misspelling someone's name—or that you need to 

exchange a particular word or phrase for another. You can use the replace feature to make 

quick revisions. In our example, we'll replace with word pounds with the abbreviations. If 

you want to replace it, select one of the replace options. Replace will replace individual 

instances, and replace all will replace every instance. In our example, we'll use 

the replace option. 
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Select All. (Ctrl+A). This command is used to select all text and objects your document and 

similar formatting. 
 

 
 

Select Objects. Select objects including ink, shapes and text areas. This is especially and 

useful when working with objects that are behind the text. 
 

Selection Pane. See a list of all your objects. This make it easier to select objects change their 

order or change their visibility. 
 

Chapter-4. Insert (Alt+N). 
 

 
 

New Slide (Ctrl+M). When you insert a new slide, it will usually have placeholders to show 

you where content will be placed. Slides have different layouts for placeholders, depending on 

the type of information you want to include. Whenever you create a new slide, you'll need to 

choose a slide layout that fits your content. Whenever you start a new presentation, it will 

contain one slide with the title slide layout. You can insert as many slides as you need from a 

variety of layouts. The new slide will appear. Click any placeholder and begin typing to add 

text. You can also click an icon to add other types of content, such as a picture or a chart. 
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Table. Tables are another tool you can used to display information in PowerPoint. A table 

is a grid of cells arranged in rows and columns. Tables are useful for various tasks, including 

presenting text information and numerical data. You can even customize tables to fit your 

presentation. Hover the mouse over the grid of squares to select the desired number 

of columns and rows in the table.  
  

 
Image.  
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Picture. Adding pictures can make your presentations more interesting and engaging. You can 

insert a pictures from a file on your computer onto any slide. PowerPoint even includes tools 

for finding online pictures and adding screenshots to your presentation. A dialog box will 

appear. Locate and select the desired image file, then click Insert. 
 

 

 

Online Picture. If you don't have the picture you want on your computer, you can find a 

picture online to add to your presentation. Powerpoint offers two options for finding online 

pictures. One drive: you can insert an image stored on your one drive. You can also link 

other online accounts with your Microsoft account, such as Facebook or Flickr. You can use 

this option to search the internet for images. By default, Bing only shows images that are 

licensed under creative commons, which means you can use them for your own projects. 

However, you should go to the image's website to see if there are any restrictions on how it 

can be used. 
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Screenshot. Screenshots are basically snapshots of your computer screen. You can take a 

screenshot of almost any program, website, or open window. Powerpoint makes it easy to 

insert a screenshot of an entire window or a screen clipping of part of a window in your 

presentation. The available windows from your desktop will appear. Select the window you 

want to capture as a screenshot. Select the insert tab, click the screenshot command, and then 

select screen clipping. 
 

 
 

Photo Album. You can create a beautiful presentation for your favourite photo collection. 
Add your pictures to a PowerPoint photo album or update a photo album with more 

photographs. 
 

New Photo Album. When creating your photo album in PowerPoint, you can add effects that 

include attention-getting slide transitions, colourful backgrounds and themes, specific layouts, 

and more to your photo albums. After you have added the pictures to your album, you can add 

captions, adjust the order and layout, add frames around the pictures, and even apply a theme 

to further customize the look of your album. 
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Shape. You can add shapes, such as boxes, circles, and arrows, to your documents, email 

messages, slide shows, and spreadsheets. To add a shape, click insert, click shapes, select a 

shape, and then click and drag to draw the shape. After you add one or more shapes, you can 

add text, bullets, and numbering to them, and you can change their fill, outline, and other 

effects on the format tab. 
 

 
 

Smart Art. A SmartArt graphic is a visual representation of information and ideas, and a chart 

is a visual illustration of numeric values or data. Basically, SmartArt graphics are designed for 

text and charts are designed for numbers. Use the information below to help you decide when 

to use a SmartArt graphic and when to use a chart.  
  

 
 



Vinod Computer Institute Mehnagar Azamgarh UP. 

--------------------------------------------------------------------------------------- 

34 | P a g e  
 

Chart. Quickly insert a chart in your presentation in PowerPoint 15. Choose from different 

types of charts and graphs, including column charts, pie charts, and more. This option is use 

to you can insert pattern and trend data bar, area, line chart. 
 

Apps for Office. New name for apps for office: office add-ins. We're currently updating our 

products, documentation, samples, and other resources to reflect the platform name change 

from "apps for office and SharePoint" to "office and SharePoint add-ins". We made this change 

to better distinguish the extension platform from office apps (applications). While these 

changes are taking place, the dialogs and messages you see in your application might be 

different than what you see in this article. 
 

Links. 
 

Hyperlink. (Ctrl+K). Add a hyperlink that links to a place in the same presentation, a different 

presentation, to a web page or site, a new file, and even an email address. Whenever you use 

the Internet, you use hyperlinks to navigate from one webpage to another. If you want to 

include a web address or email address in your PowerPoint presentation, you can choose to 

format it as a hyperlink so a person can easily click it. It's also possible to link to files and other 

slides within a presentation. 
 

 
 

Action. Another tool you can use to connect to a webpage, file, email address, or slide is called 

an action button. Action buttons are built-in shapes you can add to a presentation and set to 

link to another slide, play a sound, or perform a similar action. When someone clicks or hovers 

over the button, the selected action will occur. Action buttons can do many of the same things 
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as hyperlinks. Their easy-to-understand style makes them especially useful for self-running 

presentations at booths and kiosks. 
 

 
 

Comments. When revising or collaborating on a presentation, you might want to make notes 

or suggestions without actually changing the slide. Leaving a comment allows you to take note 

of something without altering the slide itself. Comments can be added and read by the original 

author or any other reviewers. Type your comment in the box, then press Enter or click 

anywhere outside the box to save the comment. 
 

 
 

http://www.gcflearnfree.org/powerpoint2016/hyperlinks/1/
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Text. 
 

Text Box. Draw a text box anywhere. This is a great way to get the exact text box size you 

want especially when adding text to shapes and objects. 
 

 
 

Header. Header help you to repeat content at the top of every page. They are useful for 

showcasing information like title, author, and page number. You might want to use headers 

and headers to display the document title, your name, the name of your organization and so on 

a document in print preview. The authors name and the date are entered in the header so they 

print on every page. 
 

Footer. Footers helps you repeat content at the bottom of every page. They are useful show 

casing information like title, author, and page number. Footer will appear. To edit a content 

control field, click it and type the desired information. 
 

Word Art. Word art is a quick way to make text stand out with special effects. You pick a 

word art style from the word art gallery, launched from the insert tab, which you can then 

customize. In the word art gallery, the letter a represents the different designs that are applied 

to all text you type. Click insert > word art, and pick the word art style you want. 
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Date and Time. This command is used to insert current date & time on the document. 
 

Slide Number. Number the slides in your presentation for easy reference. You can also add 

the slide number by clicking in a text box then clicking slide number. 
 

Object. Embedded objects are documents or others files you have inserted into this document. 

Instead of having separates files sometimes it’s easier to keep them all embedded in a 

document. Insert an embed objects such as word document. 
 

Symbols. 
 

Equation (Alt+=). Add common mathematical equations to your document such as the area 

of circle or the quadratic formula. You can also build your own equations using the library of 

math symbols and structures. To insert a built-in equation, click Insert > Equation and choose 

the equation you want from the gallery.𝑎2 + 𝑏2 = 𝑐2 . 
 

Symbol. Add symbols that are not on your keyboard. Choose from a variety of options 

including mathematical currency and copyrights symbols.. 
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Media. 
 

Video. PowerPoint allows you to insert a video onto a slide and play it during your 

presentation. This is a great way to make your presentation more engaging for your audience. 

You can even edit the video within PowerPoint and customize its appearance. For example, 

you can trim the video's length, add a fade in, and much more. 
 

Online Video. Some websites—like YouTube—allow you to embed videos into your slides. 

An embedded video will still be hosted on its original website, meaning the video itself won't 

be added to your file. Embedding can be a convenient way to reduce the file size of your 

presentation, but you'll also need to be connected to the Internet for the video to play. 
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Video On My Pc. Insert video from your computer or from other computer that your 

connected to locate and select the desired video file, then click insert. 
 

 

 

Audio. PowerPoint allows you to add audio to your presentation. For example, you could 

add background music to one slide, a sound effect to another, and even record your 

own narration or commentary. You can then edit the audio to customize it for your 

presentation. 
 

Record Audio. You can add audio, such as music, narration, or sound bites, to your 

PowerPoint presentation. To record and hear any audio, your computer must be equipped with 

a sound card, microphone, and speakers. 
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Chapter-5. Design (Alt+G). 
 

Themes. 
 

 
 

Themes. A theme is a predefined combination of colours, fonts, and effects. Different themes 

also use different slide layouts. You've already been using a theme, even if you didn't know it: 

the default office theme. You can choose from a variety of new themes at any time, giving 

your entire presentation a consistent, professional look. In PowerPoint, themes give you a 

quick and easy way to change the design of your presentation. They control your primary 

colour palette, basic fonts, slide layout, and other important elements. All of the elements of a 

theme will work well together, which means you won't have to spend as much time formatting 

your presentation. 
 

 

 

Colour. There are 10 theme colours, along with darker and lighter variations, available from 

every colour menu. If you apply a font or colour that isn't part of the theme, it won't change 

when you select a different theme. This includes colours selected from the standard 

colours or more colours options and fonts selected from all fonts. 
 

Font. There are two theme fonts available at the top of the Font menu under Theme Fonts. It's 

easy to apply a new set of theme fonts without changing a theme's overall look. The built-in 

theme fonts are designed to work well together, which can help to unify your presentation.  
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Effect. These affect the pre-set shape styles. You can find shape styles on the format tab 

whenever you select a shape or SmartArt graphic. Applying new theme effects will change 

different shape styles from the format tab when editing a shape or SmartArt graphic. It's 

important to note that this change will only apply to shapes using the subtle effect, moderate 

effect, and intense effect. 
 

 

 

Customize.  
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Slide Size. This option is used to change the size of your slide in this presentation. 
 

 

 

Format Background. This command is used to background or hide design element from the 

current design. To further customize your slides, you can change the background colour by 

choosing a different background style. The available background styles will vary depending 

on the current theme. If you want even more control over the background, click the format 

background command on the design tab. 
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Chapter-6. Transition (Alt+K). 
 

 
 

Preview. This option is used to play transition to this slide.  
 

Transition on This Slide. If you've ever seen a PowerPoint presentation that had special 

effects between each slide, you've seen slide transitions. A transition can be as simple as fading 

to the next slide or as flashy as an eye-catching effect. PowerPoint makes it easy to apply 

transitions to some or all of your slides, giving your presentation a polished, professional look. 
 

Effect Option. This option is used to look change to a variation of the selected transition. 

Click the effect options command and choose the desired option. These options will vary 

depending on the selected transition. 
 

Timing. 
 

Sound. This option is used to look pic a sound to play during the transition from the previous 

slide two the one. Sounds are best used in moderation. Applying a sound between every slide 

could become overwhelming or even annoying to an audience when presenting your slide 

show. 
 

 
 

Duration. This option is used to look specify the length of the. In the duration field in 

the Timing group, enter the desired time for the transition. In this example, we'll decrease the 

time to half a second—or 00.50—to make the transition faster. 
 

Apply To All. This option is used to look apply the current slide’s transition, effect’s and 

timing setting to the entire presentation. You can use apply to all command in the timing group 

to apply the same transition to all slides in your presentation. Keep in mind that this will modify 
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any other transitions you've applied. Try applying a few different types of transitions to various 

slides in your presentation. You may find that some transitions work better than others, 

depending on the content of your slides. 

Advance Slide. Normally, in slide show view you would advance to the next slide by clicking 

your mouse or by pressing the spacebar or arrow keys on your keyboard. The advance 

slides setting in the timing group allows the presentation to advance on its own and display 

each slide for a specific amount of time. This feature is especially useful 

for unattended presentations, such as those at a trade show booth. 
 

On Mouse Click. This option is used to look wait until a mouse click to move to the next 

slide. Locate the timing group on the transitions tab. Under advance slide, uncheck the box 

next to on mouse click. 
 

After. This option is used to look move to the next slide after a certain number of second. In 

the after field, enter the amount of time you want to display the slide. In this example, we will 

advance the slide automatically after 1 minute and 15 seconds, or 01:15:00. 
 

Chapter-7. Animation (Alt+A). 
 

 
 

Preview. This option is used to play the animations on this slide. 
 

Animation. Pick an animation apply to the selected object give the multiple effects single 

object. In PowerPoint, you can animate text and objects such as clip art, shapes, and pictures. 

Animation—or movement—on the slide can be used to draw the audience's attention to 

specific content or to make the slide easier to read. 
 

 
 



Vinod Computer Institute Mehnagar Azamgarh UP. 

--------------------------------------------------------------------------------------- 

45 | P a g e  
 

Effects Option. This option is used to apply the animation effects to the selected objects. Some 

effects will have options you can change. For example, with the fly in effect you can 

control which direction the object comes from. These options can be accessed from the effect 

options command in the animation group. 
 

 
 

Advance Animation. 
 

Add Animation. Choose the animation effects to add selected objects. Animations are best 

used in moderation. Adding too many animations can make your presentation look a little silly 

and can even be distracting to your audience. Consider using mostly subtle animations, or not 

using animations at all. If you select a new animation from the menu in the animation group, 

it will replace the object's current animation. However, you'll sometimes want to place more 

than one animation on an object, like an entrance and an exit effect. To do this, you'll need to 

use the add animation command, which will allow you to keep your current animations while 

adding new ones. 
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Animation Pane. Open the animation effects and edit time line on this slide. The Animation 

Pane allows you to view and manage all of the effects that are on the current slide. You 

can modify and reorder effects directly from the Animation Pane, which is especially useful 

when you have several effects. The Animation Pane will open on the right side of the window. 

It will show all of the effects for the current slide in the order in which they will appear. 
 

 

Trigger. You can set a special starting condition for an animation. You can set special 

animation to start after you click a shape or when media payback reaches a bookmark. 
 

Animation Printer (Alt+Shift+C). You can apply special effects particular objects. In some 

cases, you may want to apply the same effects to more than one object. You can do this 

by copying the effects from one object to another using the animation painter. In our example, 

we want to copy an animation from one slide to another because they have similar layouts. 
 

Timing.  
 

Start. When should animations play? By default, an effect starts playing when you click the 

mouse during a slide show. If you have multiple effects, you will need to click multiple times 

to start each effect individually. However, by changing the start option for each effect, you can 

have effects that automatically play at the same time or one after the other. 
 

Duration. Specify the length of an animation. 
 

Delay. Play the animation after a certain number of seconds. 
 

Recorder Animation.  
 

Move Earlier. This option is used to move the current animation to play earlier. 
 

Move Later. This option is used to move the current animation to play later. 
 

Chapter-8. Slide Show (Alt+S). 
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Start Slide Show. 
 

From Beginning (F5). This option is used to start the show from the first slide. Go to the slide 

show tab on the ribbon to access even more options. From here, you can start the 

presentation from the current slide and access advanced presentation options. 
 

From Current Slide (Shift+F5). Jump right in to the show at this slide. 
 

Present Online. A free public service that allow others to see your slides show in a web 

browser. You can deliver your presentation from PowerPoint using the office presentation 

service, a free, public service that allows others to follow along in their web browser. No setup 

is required. Use your free Microsoft account to get started. Presenting a slide show online is 

surprisingly easy. All you and your viewers need is an internet connection—they don't even 

need PowerPoint. Once your viewers are connected, you can start the presentation as you 

normally would. 
 

Custom Slide Show. When you create a custom show in PowerPoint, you can adapt a 

presentation for different audiences. Use a custom show to present only certain slides from 

you. There are two kinds of custom shows: basic and hyperlinked. A basic custom show is a 

separate presentation or a presentation that includes some of the slides of the original. A 

hyperlinked custom show is a quick way to navigate to one or more separate presentations. 
 

Hyperlinked Custom Shows. Use a hyperlinked custom show to organize content in a 

presentation. For instance, if you create a primary custom show about your company's new 

overall organization, you can then create a custom show for each department within the 

organization and link to these shows from the primary presentation. 
 
 

 
 

https://login.live.com/login.srf?wa=wsignin1.0&rpsnv=11&ct=1337294742&rver=6.1.6206.0&wp=sapi&wreply=https:%2f%2faccount.live.com%2fsummarypage.aspx&lc=1033&id=38936
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Set Up. 
 

Set Up Slide Show. This option is used to set up is advance options use to slide. PowerPoint 

has various options for setting up and playing a slide show. For example, you can set up an 

unattended presentation that can be displayed at a kiosk and make your slide show repeat 

with continuous looping. 
 

 

 

Show Type. You can choose show type. 
 

Show Slides. You can choose which slide you want to show during the presentation. All is 

selected by default but you can choose to show only certain slides use any custom show. 
 

Hide Show. This option is used to hide the current slide. If there is a slide that you need in 

your presentation, but you do not want it to appear in the slide show, you can hide the slide. 
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Rehearse Timings. Practice makes perfect. Start the full screen slide show the figure out the 

perfect timing for each slide. Rehearsing timings can be useful if you want to set up a 

presentation to play at a certain speed without having to click through the slides yourself. It 

also gives you the opportunity to practice your talking points. Using this feature, you can save 

timings for each slide and animation. Powerpoint will then play the presentation automatically 

using these timings. You'll be taken to a full-screen view of your presentation. Practice 

presenting your slide show. When you're ready to move to the next slide, click the next button 

on the recording toolbar in the upper-left corner. You also can also use the right arrow key on 

your keyboard. 
 

 
 

Record Slide Show. Click here to choose where to start recording, or to clear recording timing 

and narrations. The record slide show feature is similar to the rehearse timings feature, but it's 

a bit more comprehensive. If you have a microphone for your computer, you can record 

voiceover narration for the entire presentation. This is useful if you plan to use your slide show 

as a self-running presentation or video. 
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Play Narration. Play back audio narrations and laser pointer gestures during your slide show. 

You can record narrations and gestures by clicking record slide show. 
 

Use Timings. Play back slide and animation timings during the slide show. You can record 

slide and animation timings using rehearse timing or record slide show. 
 

Show Media Controls. Show the controls for playing audio and video clips when you hover 

over the clips during the slide show. 
 

Monitor. 
 

Monitor. Let PowerPoint automatically choose which monitor displays your slide show or 

pick one yourself.  
 

 

 

Use Presenter View. Presenter view show the full-screen slide show on one monitor and a 

speaker view on another monitors showing a preview of the next slide, your speaker notes a 

timer and more. If you only have one monitor you can use (Alt+F5) to try out presenter view. 

If you're presenting your slide show with a second display—like a projector—you can 

use Presenter view. Presenter view gives you access to a special set of controls on your screen 

that the audience won't see, allowing you to easily reference slide notes, preview 

the upcoming slide, and much more. 
 

Chapter-9. Review (Alt+R). 
 

 
 

Proofing. 
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Spelling & Grammar (F7). Worried about making mistakes when you type? Don't be. 

Powerpoint provides you with several proofing features—including the spelling and 

grammar tool that can help you produce professional, error-free presentations. 

The spelling pane will appear on the right. For each error in your presentation, PowerPoint 

will try to offer one or more suggestions. You can select a suggestion and click change to 

correct the error. 
 

 
 

Research (Alt+Click). Want to explore something further? Use resources such as dictionaries 

encyclopedias and translation services to get the info you need. You can also try some online 

services for more in depth research. 
 

 
 



Vinod Computer Institute Mehnagar Azamgarh UP. 

--------------------------------------------------------------------------------------- 

52 | P a g e  
 

Thesaurus (Shift+F7).  At a loss for words? Let us suggests another way to say what you 

mean.  
 

Language.  
 

Translate. Translate text into a different language by using bilingual dictionaries and online 

services. 
 

Language. Choose the language for proofing tools such as spelling check. You can also set 

other language preferences including editing display help and screen tips languages. 
 

Comments. 
 

New Comment. When revising or collaborating on a presentation, you might want to make 

notes or suggestions without actually changing the slide. Leaving a comment allows you to 

take note of something without altering the slide itself. Comments can be added and read by 

the original author or any other reviewers. 
 

 
 

Delete. This option is used to delete all comment in the document. To delete multiple 

comments, click the drop-down arrow below the Delete command. You can delete comments 

from your current slide or from the entire presentation. 
 

Previous. This option is used to jump to the previous comments. 
 

Next. This option is used to jump to the next comments. 
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Show Comments. This command is used to show all comment to the document. You can view 

or reply to any comment including other reviewers' comments by returning to 

the comments pane. Simply click a comment icon on the slide, or click the show 

comments command on the review tab. 
 

Compare. 
 

Compare. Compare two document to see different between them. There are situations in 

which you might end up with more than one version of the same presentation. For instance, 

you could create multiple drafts, or a collaborator or co-worker could save their own unique 

copy. You can easily compare and combine multiple versions using PowerPoint's compare 

feature. This allows you to see the differences between two versions of the same presentation, 

so you can decide which changes to include in the final version. 
 

Accept. Such as keep this change and move on to next one. In addition to reviewing changes 

individually, you can accept multiple changes at once. Click the accept drop-down arrow, then 

choose either accept all changes to this slide or accept all changes to the presentation. 

Reject. Undo this change and move on to the next one. 
 

 
 

Previous. This option is used to jump to the previous tracked change.  
 

Next. This option is used to jump to the next tracked change. Use the next command to view 

the next change in the presentation. You can also click previous to go back to the previous 

one. 
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Reviewing Pane. This option is used to show all change document in a list. 
 

End Review. End the presentation review apply accept and reject decision.  
 

Linked Notes. Find out how to work side-by-side in OneNote and word, PowerPoint or 

internet explorer and link your notes. 
   

Protect. 
 

Restrict Editing. You can prevent editing document and allow only commenting. 
 

Chapter-10. View (Alt+W). 
 

 

   

Presentation Views. 
 

Normal View. This option is used edit presentation side by side and navigate with thumbnails 

by using normal view. You may have noticed that when you select a different theme in 

PowerPoint, it rearranges the text on your slides and adds shapes to the background. This is 

because each theme has built-in slide layouts and background graphics. You can edit these 

layouts with a feature called slide master view. Once you learn how to use slide master view, 

you'll be able to customize your entire slide show with just a few clicks. 
 

Outline View. Edit and jump between your slides in outline pane. You can easily create an 

entire presentation just by pasting your outline from word into the outline pane. 
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Slide Sorter. See the thumbnails of all the slide in your presentation to easily rearrange them. 
  

 
 

Note Page. See how your presentation will look when printed out with notes. Each page will 

contain one slide and its speaker notes which you can edit in this view. 
 

Reading View. Play your side show in the PowerPoint windows to see animations and 

transitions without switching to a full screen slide show. 
 

Master Views.  
 

Side Master. Master slides control the look of your entire presentation including colour font 

background effects, and just about everything else. You can insert a shape or a logo on a slide 

master for example and it will show up on all your slides automatically. 
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Hand-Out Master. Customize how your presentation well look as a printed handout. You can 

choose the design and layout of the handout such as background formatting and where 

headers/footers will appear. You can also select options for your page setup. 
 

 
 

Notes Master. Customize how your presentation will look when printed out with notes. You 

can choose the design and layout of the notes page such as background formatting and where 

headers/footers will appear. You can also select options for your page setup. 
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Show.  
 

Ruler (Shift+Alt+F9). Show rulers next to your document. You can see and set tab stops 

move table borders and line up objects in the documents. Also you can measure stuff. 
  

 
 

Gridlines (Shift+F9). Show gridlines in the background of your document for perfect object 

placement. The gridlines make it easy for you to align objects with other objects or a particulars 

spot on the page. 
 

Guides. Show adjustable drawing guides to which you can align objects on the slide. 
 

Notes Pane. Add speaker notes to your slides for quicker reference during a presentation. The 

pane will appear below the current slide in normal and outline presentation view and next to 

the current slide in presenter view. 
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Zoom. 
 

Zoom. Zoom to the level that right for you. Use the control in the status bar. You can zoom in 

to get a close-up view of your file or zoom out to see more of the page at a reduced size. 
 

 
 

Fit To Window. Zoom your presentation so that the slide fills the window. 
 

Colour/Grayscale. 
 

Colour. You can view show all presentation in full colour. 
 

 
 

Grayscale. View this presentation in grayscale and customize how the colours are translated 

into grayscale. 
 

Black & White. View this presentation in black and white customize how the colours are 

translated into black and white. 
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Window. 
 

New Window. Open a second window for your document so you can work in different places 

at the same time. 
 

Arrange All. Stack your open windows so you can see all of them once.  
 

Split. See two sections of your document at the same time. This makes it easier to look at one 

section while editing another. 
 

View Side By Side. Inserted of switching back and forth between documents view them side 

by side. It makes comparing them easier. 
 

Synchronous Scrolling. Scroll two documents at the same time. This is a great way to 

compare documents line by line or scan for difference. To use this feature turn on view side 

by side.  
 

Reset Window Position. Place document you are comparing side by side so they share the 

screen equally. To use this feature turn on view side by side. 
 

Switch Windows. Quickly switch to another open window. 
 

Macro. (Alt+F8). Click to view record or pause a macro. To save time on tasks you do often, 

bundle the steps into a macro. First, you record the macro. Then you can run the macro by 

clicking a button on the quick access toolbar or pressing a combination of keys. It depends on 

how you set it up. Click view > macros > record macro. 
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Chapter-11. Microsoft PowerPoint Keyboard Shortcut Key. 

Shortcut Key. Option. 

File (Alt+F).  

Ctrl + N. New. 

Ctrl + O. Open. 

Ctrl + S. Save. 

Ctrl + Shift + S. Save As. 

Ctrl + P. Print. 

Alt + F4. Exit. 

Home (Alt+H).  

Ctrl + X. Cut. 

Ctrl + C. Copy. 

Ctrl + V. Paste. 

Ctrl + B. Bold. 

Ctrl + I. Italic. 

Ctrl + U. Underline. 

Ctrl + Shift + >. Grow Font. 

Ctrl + Shift + <. Shrink Font. 

Ctrl + L. Left. 

Ctrl + E. Centre. 

Ctrl + R. Right. 

Ctrl + J. Justify. 

Ctrl + D. Duplicate Object. 

F1. Help. 

Ctrl + F. Find. 

Ctrl + H. Replace. 

Ctrl + A. Select All. 

Ctrl + =. Subscript. 

Ctrl + Shift + ++. Superscript. 

Ctrl + Shift + D. Duplicate Slide. 

Ctrl + Z. Undo. 

Ctrl + Y. Redo. 

Ctrl + W. Close File. 

Alt + Backspace. Undo. 

Alt + F5. App Restore. 

Ctrl + Shift + B. Bold. 

Shift + F3. Change Case. 

Ctrl + Insert. Copy. 
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Ctrl + F10. Document Maximize. 

Ctrl + F5.  Document Restore. 

Alt + Shift + R. Edit. 

Ctrl + Shift +F. Font. 

F5. Full Screen. 

Ctrl + F12. Open. 

Ctrl + Alt + F2. Open. 

(Ctrl) Function Key.  

CTRL+ 1. View Normal. 

CTRL+ 2. View Outline. 

CTRL+ 3. View Notes. 

CTRL+ 4. View Slide Sorter. 

CTRL+ 5. View Reading. 

CTRL+ G. Group Shape. 

CTRL+ F4. Close File. 

CTRL+ W. Close Current File. 

CTRL+ F6. Switch the Next PowerPoint Window. 

CTRL+ F12. Open File. 

CTRL+ F1. Hide Display Ribbon. 

CTRL+ 0. Remove Single Line Space. 

CTRL+ F1. Hides or displays the Ribbon. 

CTRL+ F5. Broadcasts the Open Presentation. 

CTRL+ M. Inserts a New Slide. 

CTRL+ N. Builds a New Presentation. 

CTRL+ R. Right Align. 

CTRL+ L. Left Align. 

CTRL+ J. Justify Align. 

CTRL+ E. Centre Align. 

CTRL+ K. Creates a Link. 

(Alt) Function Key.  

Alt + 1. Left Alignment. 

Alt + 2. Align Horizontal Center. 

Alt + 3. Align Right. 

Alt + 4. Distribute Objects Horizontally. 

Alt + 5. Align to Slide. 

Alt + F10. Open the Selection Pane. 

Alt + N + O + P. Insert Audio. 

Alt + N + O + R. Insert Record Audio. 
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Alt + G + H + M. Browse for Themes. 

Alt + G + H + S. Save Current Theme. 

Alt + G + V + C + C. Design variants - Customize Colors 

Alt + G + V + F + C. Design variants - Customize Fonts. 

Alt + G + S + C. Custom Slide Size. 

Alt + A + P + P. Preview Animations. 

Alt + A + P + A. Auto Preview 

Alt + S + N + S. Start Recording from Beginning. 

Alt + N + O + O. Insert Online Audio. 

Alt + N + V + P. Insert Video on My PC. 

Alt + N + V + O. Insert Online Video. 

Alt + N + S + N. Insert Slide Number. 

Alt + H + S + O + M. Shape Outline Color Dialog. 

Alt + H + S + O + N. No Shape Outline Color. 

Alt + H + S + F + T + M. Shape Fill Texture Dialog 

Alt + H + S + F + G + M. Shape Fill Gradients Dialog. 

Alt + H + S + F + P. Shape Fill Picture. 

Alt + H + S + F + E. Shape Fill Eyedropper. 

Alt + H + S + F + M. Shape Fill Option Dialog. 

Alt + H + S + F + N. Shape Fill None. 

Alt + H + G + O + M. More Rotation Options. 

Alt + H + G + O + H. Flip Objects Horizontal 

Alt + H + G + O + V. Flip Objects Vertical. 

Alt + H + G + O + L Rotate Objects Left 90°. 

Alt + H + G + O + R. Rotate Objects Right 90°. 

Alt + H + G + A + O. Turn on Alignment of Selected Objects. 

Alt + H + G + A + A. Align Object to Slide. 

Alt +  F + C. Closes the Current Presentation. 

Alt + N + S + C+ A. Clear Timings on All Slides. 

Alt + A + P + P. Animation Painter. 

Alt + A+ S + P. Displays More Motion Paths. 

Alt + A + S + O. Displays OLE Action Verbs (Animation). 

Alt + H + S + H. Recently Used Shapes. 

Alt + S + M + W. Custom Shows. 

Alt + S + B. Starts the Slide Show. 

Alt + R + W. Ends the presentation review. 

Alt + R + V. Navigates to the previous. 

Alt + R + S. Checks the Spelling. 
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Alt + R + R. Opens the Research Task. 

Alt + R + I. Displays the reviewing pane. 

Alt + N + J. Inserts an Embedded Object. 

Alt + N + H. Edits the Header. 

Alt + N + F. Inserts Clip Art. 

Alt + N + E. Inserts Clip Art. 

Alt + N + D. Inserts the Current Date. 

Alt + N + C. Inserts a Chart. 

Alt + K + U. Selects a Sound to Play. 

Alt + K + L. Sets the Transition Between all Slides. 

Alt + H + N. Specifies the Line Numbering to Use. 

Alt + H + M. Converts Text to a SmartArt Graphic. 

Alt + H + L. Changes the Layout. 

Alt + F + O. Open File. 

Alt + F + N. New File Dialog. 

Alt + F + C. Closes the Current Presentation. 

Alt + F + S. Saves the File Under a Different Name. 

Alt + F + P. Print File Dialog. 

Alt + N + A + P + S. Insert Office App. 

(Shift) Function Key.  

Shift + F9.  Displays or Hides the Grid. 

Shift + F4. Repeats the Last Find action. 

Shift + H. Opens the Replace Dialog Box. 

Shift + F5. Starts the Slide Show. 

Shift + F7. Suggests Other Words. 

Shift + F3. Changes the Case. 

Shift + F6. Moves to a Pane. 

(Ctrl + Shift) Function Key.  

Ctrl + Shift + Y. Increase Font Size. 

Ctrl + Shift + X. Decrease Font Size. 

Ctrl + Shift + G. Object Regroup. 

Ctrl + Shift + V. Pastes Formatting Only. 

Ctrl + Shift + C. Copies Formatting Only. 

Ctrl + Shift +, Decreases the Font Size. 

Ctrl + Shift + -. Increases the Font Size. 

Ctrl + Shift + F6. Switches to the Previous PowerPoint 

Window. 

Ctrl + Shift + D. Duplicates a Selected Slide. 
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Ctrl + Shift + =. Applies Superscript Formatting. 

Function Key.  

F1. Help. 

F2. Changes Text of Element. 

F4. Opens the Look in List. 

F5. Starts the Slide Show from the First Slide. 

F6. Moves to the Next Task. 

F12. Saves the File. 

F7. Checks the Spelling. 

(Alt + Shift) Function Key.  

Alt + Shift + 1. Align Top. 

Alt + Shift + 2. Align Vertical Center. 

Alt + Shift + 3. Align Bottom. 

Alt + Shift + 4. Distribute Objects Vertically. 

Alt + Shift + W. Bring to Front. 

Alt + Shift + S. Bring Forward. 

Alt + Shift + A. Send Backward. 

Alt + Shift + Q. Send to Back. 

Alt + Shift + =. Expands Text Below a Heading. 
 

Chapter-12. Microsoft PowerPoint. Assignment-1. 
 

1.) Open a new power point slide with a name ‘your name .ppt. 

2.) Take any topic of your choice to make a presentation of list. For example.  

A. Diwali festival. 

B. Indian cricket team.  

C. Our school days.  

D. Expert academy. 
 

3.) Give the following specification to the above text.  
 

A. Heading. 

Font.                            :           Times New Roman. 

Font size.                  :           46. 

Font color.                :           Red. 

Font style.                  :           Bold. 

Alignment.                 :           Center. 
 

B. Text. 

Font.                             :           Arial. 

Font size.                     :           25. 

Font style.                     :           Italic. 
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4.) Open a new power point slide with a name ‘your name .ppt. 

5.) Take any topic of your choice to make a presentation of list. For example.  

E. Basic Course. 

F. Tally Course.  

G. Multimedia Course.  
 

6.) Give the following specification to the above text.  
 

C. Heading. 

Font.                            :           Times New Roman. 

Font size.                  :           46. 

Font color.                :           Red. 
 

D. Text. 

Font.                             :           Courier new. 

Font size.                     :           25. 

Font style.                     :           Italic. 

Alignment.                    :            Left. 

Line spacing.                :            1.5. 
 

7.) Insert a new slide between first and second slide in your presentation. 
 

8.) Insert picture (either from file clip art or from file) in one of the slides. 
 

9.) Delete a slide which you consider is not required in the presentation. 
 

10.) Change the background in two colors. 
 

11.) Use the texture in background in two colors. 
 

12.) Save the Presentation. 
 

Chapter-13. Assignment-2. 
 

 

1) Open your last save PPT presentation. 

2) Appling the following task in it. 

3) Use the animation schemes and custom animation. 

4) Every slide should be come automatically on the screen after every 10 seconds. 

5) Create a new slide and insert any picture and apply the motion on picture. 
 

6) Show all the slide by using slide sorters. 
 

7) Insert slide numbers in the slider. Also insert the system data time in the slider. 
 

8) Hide one of the slides in the presentation so that it does not show up during “slide show”. 
 

9) Save the slide using power point show option. 
 

 


